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Working with Signaling Gateway 
Mated Pairs

SGM enables you to view information about all discovered signaling gateway 
mated pairs, including their status, congestion levels, and other important 
information.

This section includes the following information:

• Viewing Basic Information for Signaling Gateway Mated Pairs, page 13-2

• Viewing Detailed Information for a Signaling Gateway Mated Pair, 
page 13-11

• Viewing Real-Time Data for a Signaling Gateway Mated Pair, page 13-25

• Attaching a Note to a Signaling Gateway Mated Pair, page 13-35

• Viewing Notes for a Signaling Gateway Mated Pair, page 13-37

• Deleting a Signaling Gateway Mated Pair, page 13-37

• Ignoring a Signaling Gateway Mated Pair, page 13-39

• Viewing Ignored Signaling Gateway Mated Pairs, page 13-40

• Viewing Signaling Gateway Mated Pair Information Using a Web Browser, 
page 13-40

Related Topics:

• Changing SGM Client Preference Settings, page 21-3

• Resizing, Sorting, and Hiding Table Columns, page 2-52
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Viewing Basic Information for Signaling Gateway 
Mated Pairs

To view basic information for signaling gateway mated pairs, select Signaling 
Gateway Mated Pairs in the left pane of the SGM Main Window. SGM displays 
the Signaling Gateway Mated Pair Window.

The Signaling Gateway Mated Pair Window provides information about all 
signaling gateway mated pairs that have been discovered by SGM, including their 
status and other important information.

The Signaling Gateway Mated Pair Window is composed of the following 
sections:

• Right-Click Menu for All Signaling Gateway Mated Pairs, page 13-3

• Right-Click Menu for a Specific Signaling Gateway Mated Pair, page 13-4

• Signaling Gateway Mated Pair Table, page 13-7

Related Topics:

• Right-Click Menu for All Signaling Gateway Mated Pairs, page 13-3

• Viewing Detailed Information for a Signaling Gateway Mated Pair, 
page 13-11

• Changing SGM Client Preference Settings, page 21-3

• Resizing, Sorting, and Hiding Table Columns, page 2-52

• Using the SGM Main Menu, page 2-9

• Viewing Notes for a Signaling Gateway Mated Pair, page 13-37
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Right-Click Menu for All Signaling Gateway Mated Pairs
To see the right-click menu for all signaling gateway mated pairs, select Signaling 
Gateway Mated Pairs in the left pane and click the right mouse button. The 
signaling gateway mated pair right-click menu provides the following options:

Menu Command Description

Show In New Window Opens the Signaling Gateway Mated Pair Window in a new window.

Sort Tree By Status Sorts the entire tree in the left pane by the status of each object.

Sort Tree By Name Sorts the entire tree in the left pane by the name of each object.

Back > List of Windows Navigates back to a window viewed in this session.

SGM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

SGM maintains a list of up to 10 Forward windows.
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Right-Click Menu for a Specific Signaling Gateway Mated Pair
The Signaling Gateway Mated Pair Window provides a subset of the SGM Main 
Menu as a right-click menu. To see this menu, select a signaling gateway mated 
pair and click the right mouse button. The signaling gateway mated pair 
right-click menu provides the following options:

Menu Command Description

Edit Notes Opens the Edit Notes Dialog for the selected signaling 
gateway mated pair.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Clear Event Icon Deletes the event icon (orange triangle) from SGM 
displays for the selected signaling gateway mated pair, for 
this SGM client only. The actual events are not deleted 
from SGM, only the event icon for the selected signaling 
gateway mated pair for this SGM client.

This option is grayed-out if the selected signaling gateway 
mated pair has no associated event icon.
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Delete Deletes the currently selected signaling gateway mated pair 
from the SGM database. SGM displays the Confirm 
Deletion dialog:

• To delete the selected signaling gateway mated pair, 
click Yes. The signaling gateway mated pair is deleted 
from the SGM database and the Confirm Deletion 
dialog is closed.

• To retain the selected signaling gateway mated pair, 
click No. The signaling gateway mated pair is kept in 
the SGM database and the Confirm Deletion dialog is 
closed.

• To prevent SGM from displaying the Confirm Deletion 
dialog, select the Do not show this again checkbox.

Note If you select the Do not show this again checkbox, 
and you later decide you want SGM to begin 
displaying the Confirm Deletion dialog again, you 
must select the Confirm Deletions checkbox in the 
General GUI settings in the Preferences window. 
For more information, see the description of the 
Confirm Deletions checkbox in the “Startup/Exit 
Settings” section on page 21-7.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (Level 4) and higher.

Go To > Node Displays the Node Window for the node associated with 
this signaling gateway mated pair.

Back > List of Windows Navigates back to a window viewed in this session.

SGM maintains a list of up to 10 Back windows.

Forward > List of Windows Navigates forward to a window viewed in this session.

SGM maintains a list of up to 10 Forward windows.

View > Configuration Details Displays the Configuration Data panel for the selected 
signaling gateway mated pair.

Menu Command Description
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View > Notes Displays the Notes panel for the selected signaling gateway 
mated pair.

If there are no notes associated with the selected signaling 
gateway mated pair, this option is grayed-out.

View > Events Displays the Recent Events panel for the selected signaling 
gateway mated pair.

View > Real-Time Data and Charts Displays the SGM Real-Time Statistics Window for the 
selected signaling gateway mated pair.

Event History > Status Change 
Messages

Displays the SGM Network Status Log for Status Change 
Messages in a Web browser, with messages displayed for 
only the selected signaling gateway mated pair.

Event History > SNMP Trap Messages Displays the SGM Network Status Log for SNMP Trap 
Messages in a Web browser, with messages displayed for 
only the selected signaling gateway mated pair.

Event History > Status and Trap 
Messages

Displays the SGM Network Status Log for Status Change 
Messages and SNMP Trap Messages in a Web browser, 
with messages displayed for only the selected signaling 
gateway mated pair.

Event History > Network Status 
Metrics

Displays the SGM Network Status Log for Metrics in a 
Web browser, with messages displayed for only the 
selected signaling gateway mated pair.

Ignore Ignores the selected signaling gateway mated pair at the 
next polling cycle.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Unignore Stops ignoring the selected signaling gateway mated pair at 
the next polling cycle.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Menu Command Description
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Signaling Gateway Mated Pair Table
The signaling gateway mated pair table displays information about the signaling 
gateway mated pairs that have been discovered by SGM.

To see mouse over help popup for each column in the table, place the cursor over 
a column header.

If a cell is too small to show all of its data, place the cursor over the cell to see the 
full data in a mouse over help popup.

You can resize each column, or sort the table based on the information in one of 
the columns. By default, this table is sorted by Status, and SGM displays all of 
the columns in the signaling gateway mated pair table except Internal ID and 
Congestion Level.

• To display hidden columns, right-click in the table header and select the 
checkboxes for the columns you want to display.

• To hide columns, right-click in the table header and clear the checkboxes for 
the columns you want to hide.

See the “Resizing, Sorting, and Hiding Table Columns” section on page 2-52 for 
more information about resizing, sorting, displaying, or hiding columns.
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The signaling gateway mated pair table contains the following columns:

Column Description

Internal ID Internal ID of the signaling gateway mated pair. The internal ID is a unique ID 
for every object, assigned by SGM for its own internal use. It can also be useful 
when the TAC is debugging problems.

Name Name of the signaling gateway mated pair.

Mate Name of the node associated with the mate of the signaling gateway mated pair.

Node Name of the node associated with the signaling gateway mated pair.

Congestion Level Indicates whether there is congestion on the signaling gateway mated pair. A 
signaling gateway mated pair is congested if it has too many packets waiting 
to be sent. This condition could be caused by the failure of an element in your 
network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to 
very heavy (7).

Ignored Indicates whether the signaling gateway mated pair is to be included when 
aggregating and displaying SGM status information:

• Clear the checkbox to include the signaling gateway mated pair. This is the 
default setting.

• Select the checkbox to exclude the signaling gateway mated pair.

This field can be edited by users with authentication level Power User (Level 
2) and higher.

Notes Indicates whether there is a note associated with the signaling gateway mated 
pair.
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Events Indicates whether there is a recent event associated with the signaling gateway 
mated pair. (Even if the server purges all of the events associated with the 
signaling gateway mated pair, SGM continues to display the event icon in this 
field.)

• To delete the event icon (orange triangle) from SGM displays for a specific 
signaling gateway mated pair, select the signaling gateway mated pair and 
click the icon.

• To delete the event icon from SGM displays for all signaling gateway 
mated pairs, select Edit > Clear All Events from the SGM Main Menu.

Note During Discovery, SGM might flag most signaling gateway mated 
pairs with an event icon. If the event icons are too distracting, use the 
Edit > Clear All Events menu option to remove them.

Last Status Change Date and time that the status of the signaling gateway mated pair last changed.

Column Description
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Status Current status of the signaling gateway mated pair. Possible values are:

Active (green)

Down (red)

Inactive (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Signaling 
Gateway Mated Pairs” section on page A-7.

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located 
at /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and 
file are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the sgm cleandiscover command to delete all current network data 
and begin a clean discovery of the ITP network. If the status reason is still 
Unsupported Configuration, enter the sgm clean command to restore the 
SGM server to a “clean” state, such as would exist after a new installation of 
SGM. For more information on the use of these commands, see the “SGM 
Command Reference” section on page C-1.

Column Description
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Viewing Detailed Information for a Signaling 
Gateway Mated Pair

SGM can display detailed information about a selected signaling gateway mated 
pair, including its status, interface information, and other information.

Updates for the signaling gateway mated pair that are received from the SGM 
server are reflected automatically in this window.

To display detailed information for a signaling gateway mated pair, use one of the 
following procedures:

• Select Signaling Gateway Mated Pairs in the left pane of the SGM Main 
Window, right-click a signaling gateway mated pair in the right pane, then 
select View > Configuration Details in the right-click menu.

• Select the turner beside Signaling Gateway Mated Pairs in the left pane of 
the SGM Main Window, then select a signaling gateway mated pair.

SGM displays the Signaling Gateway Mated Pair Details Window.

Detailed information for the selected signaling gateway mated pair is displayed in 
the left column, and for the adjacent signaling gateway mated pair in the right 
column.

The Signaling Gateway Mated Pair Details Window is composed of the following 
sections:

• Signaling Gateway Mated Pair Details: Right-Click Menu, page 13-12

• Signaling Gateway Mated Pair Details: Configuration Data, page 13-15

• Signaling Gateway Mated Pair Details: Notes, page 13-20

• Signaling Gateway Mated Pair Details: Recent Events, page 13-20

Related Topics:

• Viewing Basic Information for Signaling Gateway Mated Pairs, page 13-2
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Signaling Gateway Mated Pair Details: Right-Click Menu
The Signaling Gateway Mated Pair Details Window provides a right-click menu. 
To see this menu for a signaling gateway mated pair, select a signaling gateway 
mated pair in the left pane and click the right mouse button. The signaling gateway 
mated pair details right-click menu provides the following options:

Menu Command Description

Show In New Window Opens the Signaling Gateway Mated Pair Details Window 
for the selected signaling gateway mated pair in a new 
window.

Edit Notes Opens the Edit Notes Dialog for the selected signaling 
gateway mated pair.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Clear Event Icon Deletes the event icon (orange triangle) from SGM 
displays for the selected signaling gateway mated pair, for 
this SGM client only. The actual events are not deleted 
from SGM, only the event icon for the selected signaling 
gateway mated pair for this SGM client.

This option is grayed-out if the selected signaling gateway 
mated pair has no associated event icon.
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Delete Deletes the currently selected signaling gateway mated pair 
from the SGM database. SGM displays the Confirm 
Deletion dialog:

• To delete the selected signaling gateway mated pair, 
click Yes. The signaling gateway mated pair is deleted 
from the SGM database and the Confirm Deletion 
dialog is closed.

• To retain the selected signaling gateway mated pair, 
click No. The signaling gateway mated pair is kept in 
the SGM database and the Confirm Deletion dialog is 
closed.

• To prevent SGM from displaying the Confirm Deletion 
dialog, select the Do not show this again checkbox.

Note If you select the Do not show this again checkbox, 
and you later decide you want SGM to begin 
displaying the Confirm Deletion dialog again, you 
must select the Confirm Deletions checkbox in the 
General GUI settings in the Preferences window. 
For more information, see the description of the 
Confirm Deletions checkbox in the “Startup/Exit 
Settings” section on page 21-7.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (Level 4) and higher.

Go To > Node Displays the Node Window for the node associated with 
this signaling gateway mated pair.

Back > List of Windows Navigates back to a window viewed in this session.

SGM maintains a list of up to 10 Back windows.

Forward > List of Windows Navigates forward to a window viewed in this session.

SGM maintains a list of up to 10 Forward windows.

View > Configuration Details Displays the Configuration Data panel for the selected 
signaling gateway mated pair.

Menu Command Description
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View > Notes Displays the Notes panel for the selected signaling gateway 
mated pair.

If there are no notes associated with the selected signaling 
gateway mated pair, this option is grayed-out.

View > Events Displays the Recent Events panel for the selected signaling 
gateway mated pair.

View > Real-Time Data and Charts Displays the SGM Real-Time Statistics Window for the 
selected signaling gateway mated pair.

Event History > Status Change 
Messages

Displays the SGM Network Status Log for Status Change 
Messages in a Web browser, with messages displayed for 
only the selected signaling gateway mated pair.

Event History > SNMP Trap Messages Displays the SGM Network Status Log for SNMP Trap 
Messages in a Web browser, with messages displayed for 
only the selected signaling gateway mated pair.

Event History > Status and Trap 
Messages

Displays the SGM Network Status Log for Status Change 
Messages and SNMP Trap Messages in a Web browser, 
with messages displayed for only the selected signaling 
gateway mated pair.

Event History > Network Status 
Metrics

Displays the SGM Network Status Log for Metrics in a 
Web browser, with messages displayed for only the 
selected signaling gateway mated pair.

Ignore Ignores the selected signaling gateway mated pair at the 
next polling cycle.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Unignore Stops ignoring the selected signaling gateway mated pair at 
the next polling cycle.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Menu Command Description
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Signaling Gateway Mated Pair Details: Configuration Data
The Signaling Gateway Mated Pair Details: Configuration Data section is 
composed of the following sub-sections:

• Naming Information, page 13-15

• Status Information, page 13-15

• Interface Information, page 13-17

• Remote IP Address Information, page 13-18

• Local IP Address Information, page 13-19

Configuration data for the selected signaling gateway mated pair is displayed in 
the left column, and for the adjacent signaling gateway mated pair in the right 
column.

Naming Information

The Naming Information sub-section contains the following fields:

Status Information

The Status Information sub-section contains the following fields:

Field Description

Name Name of the signaling gateway mated pair.

Node Name of the node associated with the signaling gateway mated pair.

Association ID Index into the SNMP SCTP association table.

Is Passive Indicates whether the signaling gateway mated pair can initiate the connection to 
the mate:

• Yes—The signaling gateway mated pair is passive, and cannot initiate the 
connection to the mate.

• No—The signaling gateway mated pair is not passive, and can initiate the 
connection to the mate.
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Field Description

Is Ignored Indicates whether the signaling gateway mated pair is Ignored (that is, whether the 
signaling gateway mated pair is to be included when aggregating and displaying 
SGM status information).

Congestion Level Indicates whether there is congestion on the signaling gateway mated pair. A 
signaling gateway mated pair is congested if it has too many packets waiting to be 
sent. This condition could be caused by the failure of an element in your network.

Possible values for the Congestion Level field are None, indicating no congestion, 
and 1 to 7, indicating levels of congestion from very light (1) to very heavy (7).

Instance Status Current status of the protocol associated with the signaling gateway mated pair, 
with a color-coded background. Possible values are:

Active (green)—The protocol is available.

Shutdown (blue)—An administrator has forced the protocol to an unavailable 
state.

Unknown (red)—SGM cannot determine the current status of the protocol.

Status Current status of the signaling gateway mated pair. Possible values are:

Active (green)

Blocked (red)

Down (red)

Inactive (red)

Pending (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Application 
Server Process Associations” section on page A-3.
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Interface Information

The Interface Information sub-section contains the following fields:

Last Status 
Change

Date and time that the status of the signaling gateway mated pair last changed.

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and file 
are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the sgm cleandiscover command to delete all current network data and begin 
a clean discovery of the ITP network. If the status reason is still Unsupported 
Configuration, enter the sgm clean command to restore the SGM server to a 
“clean” state, such as would exist after a new installation of SGM. For more 
information on the use of these commands, see the “SGM Command Reference” 
section on page C-1.

Field Description

Field Description

QoS Quality of service (QoS) class of the signaling gateway mated pair.

Configured Local Port Local port number that was configured for the signaling gateway mated 
pair.

Local Port Local port number that is currently being used by the signaling gateway 
mated pair.
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Remote IP Address Information

The Remote IP Address Information sub-section contains the following fields:

Configured Remote Port Remote port number that was configured for the signaling gateway mated 
pair.

Actual Remote Port Remote port number that is currently being used by the signaling gateway 
mated pair.

Field Description

Field Description

IP Address Remote IP address associated with the signaling gateway mated pair.

Type Indicates whether this is the designated primary IP address for the signaling gateway 
mated pair (Primary), or is the IP address currently being used by the signaling 
gateway mated pair (Effective), or both (Primary/Effective).

Usually, the same IP address is both Primary and Effective. However, if the primary 
IP address is down for some reason, a different IP address is used by the signaling 
gateway mated pair and is labeled Effective.

Status Current status of the IP address. Possible values are:

Active (green)—The IP address is currently fully functional.

Inactive (red)—The IP address is not currently functional.

Cfg (12.2(4)MB10 and later) Indicates whether this remote IP address was configured for 
the signaling gateway mated pair. Possible values are:

• Yes—This is a configured remote IP address.

• (blank)—This is not a configured remote IP address.

• N/A—SGM cannot determine whether this is the configured remote IP address.

For Cisco IOS software releases prior to 12.2(4)MB10, this field always displays N/A.

Actual Indicates whether this remote IP address is currently being used by the signaling 
gateway mated pair. Possible values are:

• Yes—This IP address is being used by the signaling gateway mated pair.

• (blank)—This IP address is not being used by the signaling gateway mated pair.
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Local IP Address Information

The Local IP Address Information sub-section contains the following fields:

Field Description

IP Address Local IP address that is being used by the signaling gateway mated pair, or the 
primary IP address that is configured for the signaling gateway mated pair, or 
both.

The primary IP address is the first CS7 local IP address configured in the ITP. 
For example, if the following IP addresses are configured in the ITP:

cs7 local-peer 4180
local-ip 128.3.0.77
local-ip 128.3.0.254

then SGM uses 128.3.0.77 as the primary IP address. If at any time that IP 
address is deleted from the ITP configuration, or if a new IP address is added to 
the beginning of the list, SGM detects the change and automatically updates this 
field to reflect the new primary IP address.

Interface Name Name of the interface to which the IP address is assigned. If the signaling 
gateway mated pair has no interface name, this field is blank.

Status Current status of the IP address. Possible values are:

Active (green)—The IP address is currently fully functional.

Inactive (red)—The IP address is not currently functional.

Cfg Indicates whether this local IP address was configured for the signaling gateway 
mated pair. Possible values are:

• Yes—This is a configured local IP address.

• (blank)—This is not a configured local IP address.

Actual Indicates whether this local IP address is currently being used by the signaling 
gateway mated pair. Possible values are:

• Yes—This IP address is being used by the signaling gateway mated pair.

• (blank)—This IP address is not being used by the signaling gateway mated 
pair.
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Signaling Gateway Mated Pair Details: Notes
The Signaling Gateway Mated Pair Details: Notes section displays:

• Notes associated with the selected signaling gateway mated pair in the left 
column.

• Notes associated with the adjacent signaling gateway mated pair in the right 
column.

• The date and time the notes associated with the signaling gateway mated pair 
were last updated, or the phrase Not Set if there are no notes associated with 
the signaling gateway mated pair.

• The phrase No Notes if there are no notes associated with the signaling 
gateway mated pair.

Signaling Gateway Mated Pair Details: Recent Events
The Signaling Gateway Mated Pair Details: Recent Events table displays about all 
recent events associated with the signaling gateway mated pair, and enables you 
to perform event-related tasks, such as setting filters and acknowledging events.

To see mouse over help popup for each column in the table, place the cursor over 
a column header.

If a cell is too small to show all of its data, place the cursor over the cell to see the 
full data in a mouse over help popup.

You can resize each column, or sort the table based on the information in one of 
the columns. By default, SGM displays all of the columns in the table except 
Internal ID, Note, Message Name, Ack By, Ack Time, Node, SP, Linkset, 
Link, SGMP, ASP, AS, ASPA, Probe Conn, and Probe Link.

• To display hidden columns, right-click in the table header and select the 
checkboxes for the columns you want to display.

• To hide columns, right-click in the table header and clear the checkboxes for 
the columns you want to hide.

See the “Resizing, Sorting, and Hiding Table Columns” section on page 2-52 for 
more information about resizing, sorting, displaying, or hiding columns.
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The Signaling Gateway Mated Pair Details: Recent Events table contains the 
following toolbar buttons and columns:

Toolbar Button or Column Description

Set Filter Opens the Event Filter dialog.

Apply Filter

or

Remove Filter

Activates and deactivates the event filter specified in the Event Filter 
dialog:

• If the filter is activated, SGM displays only those events that pass 
the filter.

• If the filter is deactivated, SGM displays all events.

• If you activate a filter in an object’s Recent Events table in the SGM 
Main Window, the filter is activated in all Recent Events tables in 
the SGM Main Window for all other objects. The filter is not 
activated in Recent Events tables in Show In New Window windows 
or Real-Time Data and Charts windows.

Pause

or

Resume

Pauses or resumes the table.

While the table is paused, SGM does not display new events in the table 
(unless you apply an event filter or edit your event preferences). When 
the table is resumed, all new events since the table was paused are added 
to the display.

If events are deleted while the table is paused, they are not removed from 
the table. Instead, they are grayed-out and cannot be acknowledged or 
edited. Deleted events are removed from the table when you resume the 
table.

Acknowledge Makes the selected event or events acknowledged.

Unacknowledge Makes the selected event or events unacknowledged.

Event Properties Opens the Event Properties window.

Edit Notes Opens the Edit Event Dialog.

Time Difference Displays the difference in days, minutes, hours, and seconds between 
two events.

Find Finds specific text in the event table.

Create Sound Filter Opens the Event Sound Filters dialog and the Event Sound Filters List 
dialog, with fields populated based on the selected event.
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Adjust Row Height Adjusts the table row height and wraps the message text as follows:

• Click once to double the row height and wrap the message text.

• Click again to triple the row height and wrap the message text.

• Click again for single row height and no message text wrapping. 
This is the default setting.

This setting is saved automatically with your preferences.

Help for Event Displays context-sensitive help for the selected event in a separate Web 
browser.

Internal ID Internal ID of the event. The internal ID is a unique ID for every object, 
assigned by SGM for its own internal use. It can also be useful when the 
TAC is debugging problems.

Ack Indicates whether the event has been acknowledged:

• To acknowledge an unacknowledged event, use the Acknowledge 
toolbar button.

• To make a previously acknowledged event unacknowledged, use the 
Unacknowledge toolbar button.

Toolbar Button or Column Description
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Category Type of the event. Default values are:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has Ignored a link or linkset.

• Login—Login event. A user has logged in to SGM.

• LoginDisable—LoginDisable event. SGM has disabled a user’s 
User-Based Access authentication as a result of too many failed 
attempts to log in to SGM.

• LoginFail—LoginFail event. An attempt by a user to log in to SGM 
has failed.

• Logout—Logout event. A user has logged out of SGM.

• OverWrite—OverWrite event. An existing file, such as a seed file 
or route file, has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete 
Existing Data selected, and SGM has deleted the existing SGM 
database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field. See the “Changing Event Categories” 
section on page 5-42 for more information.

Toolbar Button or Column Description
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Severity Severity of the event. Default values are:

• Admin—The default color is cyan.

• Error—The default color is coral.

• None—The default color is white.

• Normal—The default color is light green.

• Warning—The default color is yellow.

You can customize this field. See the “Changing Event Severities and 
Colors” section on page 5-44 for more information.

Note Indicates whether there is a note associated with the event.

Message Name User-specified message name for the event, used by SGM for trap 
forwarding. The default message name is SGM.

For more information about user-specified message names and trap 
forwarding, see the “Forwarding Events as Traps to Other Hosts” section 
on page 5-59.

Time Date and time the event was logged.

Ack By If you have not implemented SGM User-Based Access, name of the 
device that last acknowledged the event.

If you have implemented SGM User-Based Access, name of the user 
who last acknowledged the event.

If no one has acknowledged the event, this field is blank.

Ack Time Date and time the event was last acknowledged or unacknowledged.

Node Name of the node associated with the event. If there is no node 
associated with the event, None is displayed.

SP Name of the signaling point associated with the event. If there is no 
signaling point associated with the event, None is displayed.

Linkset Name of the linkset associated with the event. If there is no linkset 
associated with the event, None is displayed.

Link Name of the link associated with the event. If there is no link associated 
with the event, None is displayed.

Toolbar Button or Column Description
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Viewing Real-Time Data for a Signaling Gateway 
Mated Pair

SGM enables you to view detailed statistics for a selected signaling gateway 
mated pair. Detailed information for one signaling gateway mated pair is 
displayed in the left column, and for the other in the right column.

To display detailed statistics for a signaling gateway mated pair, select Signaling 
Gateway Mated Pairs in the left pane of the SGM Main Window, right-click a 
signaling gateway mated pair in the right pane, then select View > Real-Time 
Data and Charts in the right-click menu. SGM displays the Statistics Details 
Window for a Signaling Gateway Mated Pair.

Updates for the signaling gateway mated pair that are received from the SGM 
server are reflected automatically in this window.

SGMP Name of the signaling gateway mated pair associated with the event. If 
there is no signaling gateway mated pair associated with the event, None 
is displayed.

ASP Name of the application server process associated with the event. If 
there is no application server process associated with the event, None is 
displayed.

AS Name of the application server associated with the event. If there is no 
application server associated with the event, None is displayed.

ASPA Name of the application server process association associated with the 
event. If there is no application server process association associated 
with the event, None is displayed.

Probe Conn Name of the probe connection associated with the event. If there is no 
probe connection associated with the event, None is displayed.

Probe Link Name of the probe link associated with the event. If there is no probe 
link associated with the event, None is displayed.

Message Text of the message.

You can customize this field. See the “Changing the Way SGM 
Processes Events” section on page 5-34 for more information.

Toolbar Button or Column Description
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Changes you make in this window might not be reflected throughout SGM until 
the next poll (by default, every 15 seconds). For information about changing the 
poll interval, see the “Signaling Gateway Mated Pair Statistics Details: Poll 
Settings” section on page 13-26.

Note This window polls your network periodically. To prevent unnecessary traffic on 
your network, close this window when you no longer need to refer to it.

The Statistics Details Window for a Signaling Gateway Mated Pair is composed 
of the following sections:

• Signaling Gateway Mated Pair Statistics Details: Poll Settings, page 13-26

• Signaling Gateway Mated Pair Statistics Details: Configuration Data, 
page 13-27

• Signaling Gateway Mated Pair Statistics Details: Notes, page 13-28

• Signaling Gateway Mated Pair Statistics Details: Recent Events, page 13-28

• Signaling Gateway Mated Pair Statistics Details: Interface Details, 
page 13-28

• Signaling Gateway Mated Pair Statistics Details: SCTP Assoc. Config 
Details, page 13-31

• Signaling Gateway Mated Pair Statistics Details: SCTP Assoc. Stats Details, 
page 13-34

Signaling Gateway Mated Pair Statistics Details: Poll Settings
To view or change poll settings for the Signaling Gateway Mated Pair Statistics 
Details Window, select Poll Settings in the left pane. SGM displays the Signaling 
Gateway Mated Pair Statistics Details Poll Settings panel in the right pane.

The Signaling Gateway Mated Pair Statistics Details Poll Settings panel contains 
the following fields:
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Signaling Gateway Mated Pair Statistics Details: Configuration 
Data

The information presented in the Signaling Gateway Mated Pair Statistics Details: 
Configuration Data section is the same as that presented by the “Signaling 
Gateway Mated Pair Details: Configuration Data” section on page 13-15.

Field Description

Poll Interval (secs) New poll interval for the Signaling Gateway Mated Pair Statistics 
Details Window, in seconds.

Enter the new poll interval in this field. The valid range is 15 seconds 
to an unlimited number of seconds. The default value is 15 seconds.

Current Poll Interval Current poll interval for the Signaling Gateway Mated Pair Statistics 
Details Window, in seconds.

Number of Polls Received Total number of polls received since polling began for the Signaling 
Gateway Mated Pair Statistics Details Window.

Running Time Total elapsed time since polling began for the Signaling Gateway 
Mated Pair Statistics Details Window.

Last Message Date and time of the last poll for the Signaling Gateway Mated Pair 
Statistics Details Window.

Poll Counter Mode Displays the current mode for poll counters, and the date and time that 
counters were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last 
reboot of the ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the 
last poll.

• Since User Reset—Counters display values aggregated since the 
last time they were reset by the user.

Reset Counters Opens the SGM Reset Counters Dialog, which enables you to change 
SGM poller and counter settings. For more information, see the 
“Changing Real-Time Poller and Counter Settings” section on 
page 2-72.
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Signaling Gateway Mated Pair Statistics Details: Notes
The information presented in the Signaling Gateway Mated Pair Statistics Details: 
Notes section is the same as that presented by the “Signaling Gateway Mated Pair 
Details: Notes” section on page 13-20.

Signaling Gateway Mated Pair Statistics Details: Recent Events
The information presented in the Signaling Gateway Mated Pair Statistics Details: 
Recent Events section is the same as that presented by the “Signaling Gateway 
Mated Pair Details: Recent Events” section on page 13-20.

Signaling Gateway Mated Pair Statistics Details: Interface 
Details

The Signaling Gateway Mated Pair Statistics Details: Interface Details section 
provides a tab for each interface used by the selected signaling gateway mated 
pair. To see information for an interface, select its tab.

The Signaling Gateway Mated Pair Statistics Details: SCTP Assoc. Config 
Details section is composed of the following sub-sections:

• Configuration Information, page 13-29

• Status Information, page 13-29

• Statistics Information, page 13-30

• Errors Information, page 13-31
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Configuration Information

The Configuration Information sub-section contains the following fields:

Status Information

The Status Information sub-section contains the following fields:

Field Description

Type Type of interface, such as Ethernet.

MTU Size, in bytes, of the largest datagram that can be sent or received on the 
interface.

Speed (Bits/Sec) Estimate, in bits per second, of the interface's current bandwidth. If the 
interface does not vary in bandwidth, or if no accurate estimate can be made, 
this field displays the nominal bandwidth.

IP Address IP address corresponding to the media-dependent “physical” address.

IP Mask Subnet mask corresponding to the media-dependent “physical” address.

Physical Address Address of the interface at the protocol layer immediately “below” the 
network layer in the protocol stack.

Field Description

ITP Uptime Time the interface has been up, in days, hours, minutes, and seconds.

Admin Status Desired state of the interface. Possible values are:

• Up

• Down

• Testing
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Statistics Information

The Statistics Information sub-section contains the following fields:

Operational Status Current operational state of the interface. Possible values are:

• Up

• Down

• Testing

• Unknown

• Dormant

Line Protocol Status Current state of the line protocol. Possible values are:

• Up—Software processes that handle the line protocol consider the line 
to be usable (that is, keepalives are successful).

• Down—Software processes that handle the line protocol consider the 
line to be unusable.

You can use the Line Protocol together with Operational Status to 
troubleshoot interface connection problems. For example, if Operational 
Status is Up, but Line Protocol is Down, the interface has detected a carrier 
on the physical layer, but there might be clocking or framing problems.

Field Description

Field Description

Bytes In per Sec Number of bytes received on the interface per second, including framing 
characters.

Bytes Out per Sec Number of bytes sent on the interface per second, including framing 
characters.

Packets In per Sec Number of packets delivered per second to a higher-layer protocol.

Packets Out per Sec Total number of packets that higher-level protocols requested to be sent to 
the network per second, including those that were discarded or not sent.
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Errors Information

The Errors Information sub-section contains the following fields:

Signaling Gateway Mated Pair Statistics Details: SCTP Assoc. 
Config Details

The Signaling Gateway Mated Pair Statistics Details: SCTP Assoc. Config 
Details section is composed of the following sub-sections:

• Configuration Information, page 13-32

• Local IP Address Information, page 13-32

• Remote IP Address Information, page 13-33

• Transmission Configuration Information, page 13-33

Field Description

In Discards Number of inbound packets that were discarded, even though no errors were 
detected to prevent their delivery to a higher-layer protocol. For example, a 
packet might be discarded to free buffer space.

Out Discards Number of outbound packets that were discarded, even though no errors 
were detected to prevent their delivery to a higher-layer protocol. For 
example, a packet might be discarded to free buffer space.

In Errors Number of inbound packets that contained errors that prevented their 
delivery to a higher-layer protocol.

Out Errors Number of outbound packets that were not sent because of errors.
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Configuration Information

The Configuration Information sub-section contains the following fields:

Local IP Address Information

The Local IP Address Information sub-section contains the following fields:

Field Description

Status Current status of the SCTP association. Possible values are:

• Closed

• CookieWait

• CookieEchoed

• DeleteTCB

• Established

• ShutdownAckSent

• ShutdownPending

• ShutdownReceived

• ShutdownSent

For detailed information about each status, refer to RFC 2960, Stream 
Control Transmission Protocol.

Uptime Time the link has been up, in days, hours, minutes, and seconds.

Actual Remote Port Remote port number for the SCTP association.

Local Port Local port number for the SCTP association.

Primary IP Address Designated primary IP address for the SCTP association.

Effective IP Address IP address currently being used by the SCTP association.

Field Description

IP Address Local IP addresses associated with the link.

Uptime Time each local IP address associated with the link has been up, in days, 
hours, minutes, and seconds.
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Remote IP Address Information

The Remote IP Address Information sub-section contains the following fields:

Transmission Configuration Information

The Transmission Configuration Information sub-section contains the following 
fields:

Field Description

IP Address Remote IP addresses associated with the link.

Uptime Time each remote IP address associated with the link has been up, in days, 
hours, minutes, and seconds.

Retry Timeout (msecs) Current SCTP Retransmission Timeout (T3-rtx timer).

Maximum Retries Maximum number of retransmissions allowed before this IP address is 
considered inactive.

Retries Current retransmission count.

Field Description

MTU Maximum transmission unit (MTU) size to be used by this SCTP 
association. This is the smallest MTU size supported by any of the IP 
addresses used by the SCTP association.

In Streams Inbound streams as negotiated when the SCTP association was started.

Out Streams Outbound streams as negotiated when the SCTP association was started.

Maximum Retries Maximum number of data retransmissions in the SCTP association context.

Local Receive Window 
Size

Current local receive window size for this SCTP association.

Remote Receive 
Window Size

Current local send window size for this SCTP association.

Initial Retry Timeout 
(msecs)

Initial timeout value, in milliseconds, permitted by the SCTP 
implementation for the retry timeout.

Minimum Retry 
Timeout (msecs)

Minimum timeout value, in milliseconds, permitted by the SCTP 
implementation for the retry timeout.
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Signaling Gateway Mated Pair Statistics Details: SCTP Assoc. 
Stats Details

The Signaling Gateway Mated Pair Statistics Details: SCTP Assoc. Stats Details 
section is composed of the following sub-sections:

• Remote IP Address Information, page 13-34

• Statistics Information (per sec) Rates, page 13-35

Remote IP Address Information

The Remote IP Address Information sub-section contains the following fields:

Maximum Retry 
Timeout (msecs)

Maximum timeout value, in milliseconds, permitted by the SCTP 
implementation for the retry timeout.

Bundle Chunks Indicates whether the SCTP protocol allows chunks to be bundled into a 
single datagram as follows. Valid values are:

• true (1)—Chunks are bundled.

• false (2)—Chunks are not bundled.

Bundle Timeout 
(msecs)

Time, in milliseconds, to wait to allow data chunks to accumulate so that 
they can be transmitted in the same datagram.

Field Description

Field Description

IP Address Remote IP addresses associated with the link.

Smoothed Round Trip 
Time (msecs)

Average, in milliseconds, of all round-trip times between the local and 
remote systems on an IP network.

Failure Count Number of times the remote IP address was marked as failed.

Heartbeat Status Current status of the heartbeat associated with the remote IP address. Valid 
values are Active and Inactive.

IP Status Current status of the remote IP address. Valid values are Active and 
Inactive.
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Statistics Information (per sec) Rates

The Statistics Information (per sec) Rates sub-section contains the following 
fields:

Attaching a Note to a Signaling Gateway Mated Pair
SGM enables you to annotate a signaling gateway mated pair, attaching a 
descriptive string to it.

To attach a note to a signaling gateway mated pair, right-click the signaling 
gateway mated pair in a window, then select Edit > Notes in the right-click menu. 
SGM displays the Edit Notes Dialog for a Signaling Gateway Mated Pair.

Field Description

Packets Sent Number of IP datagrams sent per second by this SCTP association.

Packets Received Number of IP datagrams received per second by this SCTP association.

Control Chunks Sent Number of control chunks sent per second by this SCTP association.

Control Chunks Rec Number of control chunks received per second by this SCTP association.

Ordered Chunks Sent Number of ordered chunks sent per second by this SCTP association.

Ordered Chunks Rec Number of ordered chunks received per second by this SCTP 
association.

Unordered Chunks Sent Number of unordered chunks sent per second by this SCTP association.

Unordered Chunks Rec Number of unordered chunks received per second by this SCTP 
association.

Retransmitted Chunks Number of chunks retransmitted per second by this SCTP association.

Retransmitted Fast 
Chunks

Number of fast chunks retransmitted per second by this SCTP 
association.
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The Edit Notes Dialog for a Signaling Gateway Mated Pair contains the following 
fields and buttons:

Related Topics:

• Viewing Basic Information for Signaling Gateway Mated Pairs, page 13-2

• Viewing Detailed Information for a Signaling Gateway Mated Pair, 
page 13-11

• Viewing Notes for a Signaling Gateway Mated Pair, page 13-37

Field or Button Description

Name Name of the signaling gateway mated pair. You cannot edit this field.

Note Last Updated Date and time the Notes field for this signaling gateway mated pair was last 
updated. If there is no note currently associated with this signaling gateway 
mated pair, this field displays the value Not Set.

You cannot edit this field.

Notes Notes to associate with this signaling gateway mated pair. In this field, you can 
enter any important information about the signaling gateway mated pair, such as 
a detailed description, its location, its service history, and so on.

Save Saves changes you have made to the signaling gateway mated pair’s notes, 
updates all SGM windows to reflect your changes, and exits the dialog.

When you annotate a signaling gateway mated pair, the topology map in the 
Topology Window displays a note icon in the upper left corner of the signaling 
gateway mated pair element.

Cancel Exits the dialog without saving any changes.

Help Displays online help for the dialog.
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Viewing Notes for a Signaling Gateway Mated Pair
SGM enables you to view any notes that have been associated with a signaling 
gateway mated pair.

To view a note for a signaling gateway mated pair, right-click a signaling gateway 
mated pair in a window, then select View > Notes in the right-click menu. (The 
Notes option is grayed-out if there is no note associated with the selected 
signaling gateway mated pair.)

SGM displays the Notes panel for the selected signaling gateway mated pair, 
which displays:

• Notes associated with the selected signaling gateway mated pair in the left 
column.

• Notes associated with the adjacent signaling gateway mated pair in the right 
column.

• The date and time the notes associated with the signaling gateway mated pair 
were last updated, or the phrase Not Set if there are no notes associated with 
the signaling gateway mated pair.

• The phrase No Notes if there are no notes associated with the signaling 
gateway mated pair.

Related Topics:

• Attaching a Note to a Signaling Gateway Mated Pair, page 13-35

Deleting a Signaling Gateway Mated Pair
After Discovery, the signaling gateway mated pairs in your network are known to 
SGM and added to the SGM database. Physically deleting signaling gateway 
mated pairs from your network is not the same as deleting them from the SGM 
database. The following sections describe the differences between deleting 
signaling gateway mated pairs from your network and deleting them from the 
SGM database, and the procedures for doing so:

• Deleting a Signaling Gateway Mated Pair from Your Network, page 13-38

• Deleting a Signaling Gateway Mated Pair from the SGM Database, 
page 13-38
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Deleting a Signaling Gateway Mated Pair from Your Network
If you physically delete a known signaling gateway mated pair from your network 
(for example, by powering down an ITP), it remains in the SGM database, SGM 
labels it Unknown, and it is the system administrator’s responsibility to delete it 
from the SGM database, if you choose to do so.

Deleting a Signaling Gateway Mated Pair from the SGM 
Database

Typically, you delete a signaling gateway mated pair from the SGM database for 
one of the following reasons:

• You have physically deleted the signaling gateway mated pair from your 
network. This is the most common reason for deleting a signaling gateway 
mated pair from the SGM database.

• The signaling gateway mated pair is Down, Inactive, or Unknown, you are 
aware of the reason, and you no longer want to see it in SGM displays. For 
example, the signaling gateway mated pair might be a test lab device.

If you have physically deleted a known signaling gateway mated pair from your 
network, and you then delete it from SGM, it is no longer in the SGM database, 
it does not appear in SGM windows, and it is not discovered when you run 
Discovery.

If you have not physically deleted a known signaling gateway mated pair from 
your network, and you delete it from SGM, at the next poll SGM finds the 
signaling gateway mated pair and adds it back to the SGM database, setting the 
status appropriately. If this happens, do not delete the signaling gateway mated 
pair again. Instead, set it to Ignored. See the “Ignoring a Signaling Gateway 
Mated Pair” section on page 13-39 for more information.

Note If you delete a signaling gateway mated pair from the SGM database, the 
signaling gateway mated pair is deleted for all SGM clients and views connected 
to that SGM server.
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To delete a signaling gateway mated pair from the SGM database, use one of the 
following procedures:

• Select one or more signaling gateway mated pairs in a window, then select 
Edit > Delete from the SGM Main Menu.

• Right-click a signaling gateway mated pair in a window, then select Delete in 
the right-click menu. (You cannot delete more than one signaling gateway 
mated pair at a time from the right-click menu.)

SGM asks you to confirm the deletion:

• Select Yes to delete the selected signaling gateway mated pairs. SGM deletes 
the signaling gateway mated pairs from the SGM database.

• Select No to return to the window without deleting any signaling gateway 
mated pairs from the SGM database.

Ignoring a Signaling Gateway Mated Pair
You can instruct SGM to ignore a signaling gateway mated pair when it aggregates 
and displays network data. Setting signaling gateway mated pairs to Ignored 
prevents known signaling gateway mated pair problems from affecting SGM 
displays for associated objects. In effect, you are preventing a known problem 
from distracting you from other, more urgent network problems.

For example, you can set a signaling gateway mated pair to Ignored before 
shutting down the signaling gateway mated pair for maintenance.

Note If you set a signaling gateway mated pair to Ignored, the signaling gateway mated 
pair is ignored for all SGM clients and views connected to that SGM server.

Also, if you set a signaling gateway mated pair to Ignored, make a note of the 
change, and do not forget to reset the signaling gateway mated pair when the 
problem is corrected or the maintenance is complete.

To set a signaling gateway mated pair to Ignored, right-click the signaling 
gateway mated pair in the Signaling Gateway Mated Pair Details window, then 
select Ignore from the right-click menu.
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Viewing Ignored Signaling Gateway Mated Pairs
To display all signaling gateway mated pairs that are Ignored, display the 
Signaling Gateway Mated Pair Window and click the Ignored column header. 
SGM displays all ignored signaling gateway mated pairs at the top of the table.

Viewing Signaling Gateway Mated Pair Information 
Using a Web Browser

SGM enables you to use a Web browser to view the following information about 
signaling gateway mated pairs:

• Viewing the Network Status Signaling Gateway Mated Pair Dashboard, 
page 13-40

• Viewing ITP Signaling Gateway Mated Pair Status, page 13-42

• Viewing ITP Signaling Gateway Mated Pair Details, page 13-44

• Viewing Interface Details for a Signaling Gateway Mated Pair, page 13-48

• Viewing SCTP Association Details for a Signaling Gateway Mated Pair, 
page 13-50

Viewing the Network Status Signaling Gateway Mated Pair 
Dashboard

The SGM Signaling Gateway Mated Pair Dashboard page lists all discovered 
signaling gateway mated pairs, and provides links to messages and metrics for 
each signaling gateway mated pair.

To access the SGM Signaling Gateway Mated Pair Dashboard page, select 
Network Status Dashboard from the SGM Server Home Page, then click 
SGMP Dashboard.
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The Signaling Gateway Mated Pair Dashboard table contains the following 
columns:

Column Description

Server Name
(in header)

Name of the SGM server associated with the signaling gateway mated pair.

Update Interval
(in header)

Time between automatic updates for the page. None means the page is not 
automatically updated.

Last Update
(in header)

Date and time the information on the page was last updated by SGM.

SGMP Signaling gateway mated pairs discovered by SGM.

You can sort the table based on the information in the SGMP column. See the 
“Resizing, Sorting, and Hiding Table Columns” section on page 2-52 for more 
details.

Drill-Down Links: 
Messages

Displays messages associated with a given signaling gateway mated pair. To see 
status change messages and SNMP trap messages associated with the signaling 
gateway mated pair, click Messages.

Drill-Down Links: 
Metrics

Displays metrics associated with a given signaling gateway mated pair. To see 
network status metrics associated with the signaling gateway mated pair, click 
Metrics.

Drill-Down Links: 
Interface Details

Displays detailed interface information for a given signaling gateway mated pair. 
To see interface information for the signaling gateway mated pair, click 
Interface Details.

This field is displayed only if the selected signaling gateway mated pair is not a 
virtual signaling gateway mated pair, has a status of Active or Warning, and is 
connected to an ITP device.

Drill-Down Links: 
SCTP Association 
Details

Displays detailed SCTP association information for a given signaling gateway 
mated pair. To see SCTP association information for the signaling gateway mated 
pair, click SCTP Association Details.

This field is displayed only if the selected signaling gateway mated pair is not a 
virtual signaling gateway mated pair, has a status of Active or Warning, and is 
connected to an ITP device.
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Viewing ITP Signaling Gateway Mated Pair Status
The SGM Signaling Gateway Mated Pairs Status page displays information about 
all discovered signaling gateway mated pairs, including their names, status, and 
other important information.

To access the SGM Signaling Gateway Mated Pairs Status page, select ITP 
SGMP Status from the SGM Server Home Page.

You can sort the Signaling Gateway Mated Pairs Status table based on the 
information in any column. See the “Resizing, Sorting, and Hiding Table 
Columns” section on page 2-52 for more details.

The Signaling Gateway Mated Pairs table contains the following columns:

Column Description

Server Name
(in header)

Name of the SGM server associated with the signaling gateway mated pair.

Update Interval
(in header)

Time between automatic updates for the page.

Last Update
(in header)

Date and time the information on the page was last updated by SGM.

SGMP Name Name of the signaling gateway mated pair.

To see detailed information for the signaling gateway mated pair, click the 
signaling gateway mated pair name.

Node Name of the node associated with the signaling gateway mated pair.

To see detailed information for the node, click the node name.
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Status Current status of the signaling gateway mated pair, with a color-coded 
background. Possible values are:

Active (green)

Down (red)

Inactive (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Signaling 
Gateway Mated Pairs” section on page A-7.

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and file 
are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the sgm cleandiscover command to delete all current network data and 
begin a clean discovery of the ITP network. If the status reason is still 
Unsupported Configuration, enter the sgm clean command to restore the SGM 
server to a “clean” state, such as would exist after a new installation of SGM. For 
more information on the use of these commands, see the “SGM Command 
Reference” section on page C-1.

Column Description
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Viewing ITP Signaling Gateway Mated Pair Details
The SGM Signaling Gateway Mated Pairs Details page displays detailed 
information about a signaling gateway mated pair.

To access the SGM Signaling Gateway Mated Pairs Details page, click the 
signaling gateway mated pair name on the SGM Signaling Gateway Mated Pairs 
Status page.

You can sort the Signaling Gateway Mated Pairs Details table based on the 
information in any column. See the “Resizing, Sorting, and Hiding Table 
Columns” section on page 2-52 for more details.

The Signaling Gateway Mated Details table contains the following columns:

Instance Status Current status of the protocol associated with the signaling gateway mated pair, 
with a color-coded background. Possible values are:

Active (green)—The protocol is available.

Shutdown (blue)—An administrator has forced the protocol to an unavailable 
state.

Unknown (red)—SGM cannot determine the current status of the protocol.

Congestion Indicates whether there is congestion on the signaling gateway mated pair. A 
signaling gateway mated pair is congested if it has too many packets waiting to 
be sent. This condition could be caused by the failure of an element in your 
network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to very 
heavy (7).

Column Description

Column Description

Server Name
(in header)

Name of the SGM server associated with the signaling gateway mated pair.

Update Interval
(in header)

Time between automatic updates for the page.
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Last Update
(in header)

Date and time the information on the page was last updated by SGM.

Node Name of the node associated with the signaling gateway mated pair.

To see detailed information for the node, click the node name.

SGMP Name Name of the signaling gateway mated pair.

To see detailed information for the signaling gateway mated pair, click the 
signaling gateway mated pair name.

Drill-Down Links: 
Messages

Displays messages associated with a given signaling gateway mated pair. To 
see status change messages and SNMP trap messages associated with the 
signaling gateway mated pair, click Messages.

Drill-Down Links: 
Metrics

Displays metrics associated with a given signaling gateway mated pair. To see 
network status metrics associated with the signaling gateway mated pair, click 
Metrics.

Drill-Down Links: 
Interface Details

Displays detailed interface information for a given signaling gateway mated 
pair. To see interface information for the signaling gateway mated pair, click 
Interface Details.

This field is displayed only if the selected signaling gateway mated pair is not 
a virtual signaling gateway mated pair, has a status of Active or Warning, and 
is connected to an ITP device.

Drill-Down Links: 
SCTP Association 
Details

Displays detailed SCTP association information for a given signaling gateway 
mated pair. To see SCTP association information for the signaling gateway 
mated pair, click SCTP Association Details.

This field is displayed only if the selected signaling gateway mated pair is not 
a virtual signaling gateway mated pair, has a status of Active or Warning, and 
is connected to an ITP device.

Column Description
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Status Current status of the signaling gateway mated pair, with a color-coded 
background. Possible values are:

Active (green)

Down (red)

Inactive (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Signaling 
Gateway Mated Pairs” section on page A-7.

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located 
at /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and 
file are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the sgm cleandiscover command to delete all current network data 
and begin a clean discovery of the ITP network. If the status reason is still 
Unsupported Configuration, enter the sgm clean command to restore the 
SGM server to a “clean” state, such as would exist after a new installation of 
SGM. For more information on the use of these commands, see the “SGM 
Command Reference” section on page C-1.

Column Description
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Instance Status Current status of the protocol associated with the signaling gateway mated pair, 
with a color-coded background. Possible values are:

Active (green)—The protocol is available.

Shutdown (blue)—An administrator has forced the protocol to an unavailable 
state.

Unknown (red)—SGM cannot determine the current status of the protocol.

Congestion Indicates whether there is congestion on the signaling gateway mated pair. A 
signaling gateway mated pair is congested if it has too many packets waiting 
to be sent. This condition could be caused by the failure of an element in your 
network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to 
very heavy (7).

Note Note associated with this signaling gateway mated pair. If there is no note 
associated with this signaling gateway mated pair, this field is blank.

Note Timestamp Date and time the note associated with this signaling gateway mated pair was 
last updated. If there is no note associated with this signaling gateway mated 
pair, this field is blank.

QoS Quality of service (QoS) class of the signaling gateway mated pair.

Passive Indicates whether the signaling gateway can initiate the connection with the 
mate. Possible values are:

• True—The signaling gateway cannot initiate the connection. The mate 
must initiate the connection.

• False—The signaling gateway can initiate the connection.

Config Local Port Local port number that was configured for the signaling gateway mated pair.

Local Port Local port number that is currently being used by the signaling gateway mated 
pair.

Config Remote Port Remote port number that was configured for the signaling gateway mated pair.

Remote Port Remote port number that is currently being used by the signaling gateway 
mated pair.

Column Description
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Viewing Interface Details for a Signaling Gateway Mated Pair
The SGM Interface Details page displays detailed interface information for a 
signaling gateway mated pair.

To access the SGM Interface Details page, select Interface Details in the SGM 
Signaling Gateway Mated Pairs Details page.

The SGM Interface Details table displays the following information for the 
selected signaling gateway mated pair:

Field Description

Server Name
(in header)

Name of the SGM server associated with the signaling gateway mated pair.

Update Interval
(in header)

Time between automatic updates for the page.

Last Update
(in header)

Date and time the information on the page was last updated by SGM.

Node Name of the node associated with the signaling gateway mated pair.

To see detailed information for the node, click the node name.

SGMP Name of the signaling gateway mated pair.

To see detailed information for the signaling gateway mated pair, click the 
signaling gateway mated pair name.

Description Text string containing information about the interface.

IP Address IP address corresponding to the media-dependent “physical” address. If the 
interface does not have such an address (for example, a serial line), this field 
displays N/A.

Mask Subnet mask corresponding to the media-dependent “physical” address. If the 
interface does not have such an address (for example, a serial line), this field 
displays N/A.

Type Type of interface, such as Ethernet.

MTU Size, in bytes, of the largest datagram that can be sent or received on the 
interface.
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Speed (Bits/Sec) Estimate, in bits per second, of the interface's current bandwidth. If the 
interface does not vary in bandwidth, or if no accurate estimate can be made, 
this field displays the nominal bandwidth.

Physical Address (SCTP links only) Address of the interface at the protocol layer immediately 
“below” the network layer in the protocol stack. If the interface does not have 
such an address (for example, a serial line), this field displays N/A.

ITP Uptime Time the interface has been up, in days, hours, minutes, and seconds.

Admin Status Desired state of the interface. Possible values are:

• Up

• Down

• Testing

Operational Status Current operational state of the interface. Possible values are:

• Up

• Down

• Testing

• Unknown

• Dormant

Line Protocol Status Current state of the line protocol. Possible values are:

• Up—Software processes that handle the line protocol consider the line to 
be usable (that is, keepalives are successful).

• Down—Software processes that handle the line protocol consider the line 
to be unusable.

You can use the Line Protocol together with Operational Status to 
troubleshoot interface connection problems. For example, if Operational 
Status is Up, but Line Protocol is Down, the interface has detected a carrier 
on the physical layer, but there might be clocking or framing problems.

Bytes In per Sec Number of bytes received on the interface per second, including framing 
characters.

Bytes Out per Sec Number of bytes sent on the interface per second, including framing 
characters.

Packets In per Sec Number of packets delivered per second to a higher-layer protocol.

Field Description
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Viewing SCTP Association Details for a Signaling Gateway 
Mated Pair

The SGM SCTP Association Details page displays detailed SCTP association 
information for a signaling gateway mated pair.

To access the SGM SCTP Association Details page, select SCTP Association 
Details in the SGM Signaling Gateway Mated Pairs Details page.

The SGM SCTP Association Details table displays the following information for 
the selected signaling gateway mated pair:

Packets Out per Sec Total number of packets that higher-level protocols requested to be sent to the 
network per second, including those that were discarded or not sent.

In Discards Number of inbound packets that were discarded, even though no errors were 
detected to prevent their delivery to a higher-layer protocol. For example, a 
packet might be discarded to free buffer space.

Out Discards Number of outbound packets that were discarded, even though no errors were 
detected to prevent their delivery to a higher-layer protocol. For example, a 
packet might be discarded to free buffer space.

In Errors Number of inbound packets that contained errors that prevented their delivery 
to a higher-layer protocol.

Out Errors Number of outbound packets that were not sent because of errors.

Field Description

Field Description

Server Name
(in header)

Name of the SGM server to which this SCTP association belongs.

Update Interval
(in header)

Time between automatic updates for the page.

Last Update
(in header)

Date and time the information on the page was last updated by SGM.

Node Name of the node to which this SCTP association belongs. To see 
detailed information for the node, click the node name.
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SGMP Name of the signaling gateway mated pair to which this SCTP 
association belongs. To see detailed information for the signaling 
gateway mated pair, click the signaling gateway mated pair name.

Status Current status of the SCTP association. Possible values are:

• Closed

• CookieWait

• CookieEchoed

• DeleteTCB

• Established

• ShutdownAckSent

• ShutdownPending

• ShutdownReceived

• ShutdownSent

For detailed information about each status, refer to RFC 2960, Stream 
Control Transmission Protocol.

Uptime Time the link has been up, in days, hours, minutes, and seconds.

Remote Port Remote port number for the SCTP association.

Local Port Local port number for the SCTP association.

Primary IP Address Designated primary IP address for the SCTP association.

Effective IP Address IP address currently being used by the SCTP association.

Local IP Address 
Configuration: IP Address

Local IP addresses associated with the link.

Local IP Address 
Configuration: Uptime

Time each local IP address associated with the link has been up, in days, 
hours, minutes, and seconds.

Remote IP Address 
Configuration: IP Address

Remote IP addresses associated with the link.

Remote IP Address 
Configuration: Uptime

Time each remote IP address associated with the link has been up, in 
days, hours, minutes, and seconds.

Field Description
13-51
Cisco Signaling Gateway Manager User Guide

OL-5805-01



 

Chapter 13      Working with Signaling Gateway Mated Pairs
Viewing Signaling Gateway Mated Pair Information Using a Web Browser
Remote IP Address 
Configuration: Retry 
Timeout (msecs)

Current SCTP Retransmission Timeout (T3-rtx timer).

Remote IP Address 
Configuration: Maximum 
Retries

Maximum number of retransmissions allowed before this IP address is 
considered inactive.

Remote IP Address 
Configuration: Retries

Current retransmission count.

Remote IP Address Status: 
IP Address

Remote IP addresses associated with the link.

Remote IP Address Status: 
Smoothed Round Trip 
Time (msecs)

Average, in milliseconds, of all round-trip times between the local and 
remote systems on an IP network.

Remote IP Address Status: 
Failure Count

Number of times the remote IP address was marked as failed.

Remote IP Address Status: 
Heartbeat Status

Current status of the heartbeat associated with the remote IP address. 
Valid values are Active and Inactive.

Remote IP Address Status: 
IP Status

Current status of the remote IP address. Valid values are Active and 
Inactive.

Packets Sent per Sec. Number of IP datagrams sent per second by this SCTP association.

Packets Received per Sec. Number of IP datagrams received per second by this SCTP association.

Control Chunks Sent per 
Sec.

Number of control chunks sent per second by this SCTP association.

Control Chunks Received 
per Sec.

Number of control chunks received per second by this SCTP association.

Ordered Chunks Sent per 
Sec.

Number of ordered chunks sent per second by this SCTP association.

Ordered Chunks Received 
per Sec.

Number of ordered chunks received per second by this SCTP 
association.

Unordered Chunks Sent 
per Sec.

Number of unordered chunks sent per second by this SCTP association.

Unordered Chunks 
Received per Sec.

Number of unordered chunks received per second by this SCTP 
association.

Field Description
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Retransmitted Chunks per 
Sec.

Number of chunks retransmitted per second by this SCTP association.

Retransmitted Fast 
Chunks per Sec.

Number of fast chunks retransmitted per second by this SCTP 
association.

MTU Maximum transmission unit (MTU) size to be used by this SCTP 
association. This is the smallest MTU size supported by any of the IP 
addresses used by the SCTP association.

In Streams Inbound streams as negotiated when the SCTP association was started.

Out Streams Outbound streams as negotiated when the SCTP association was started.

Maximum Retries Maximum number of data retransmissions in the SCTP association 
context.

Local Receive Window 
Size

Current local receive window size for this SCTP association.

Remote Receive Window 
Size

Current local send window size for this SCTP association.

Initial Retry Timeout 
(msecs)

Initial timeout value, in milliseconds, permitted by the SCTP 
implementation for the retry timeout.

Minimum Retry Timeout 
(msecs)

Minimum timeout value, in milliseconds, permitted by the SCTP 
implementation for the retry timeout.

Maximum Retry Timeout 
(msecs)

Maximum timeout value, in milliseconds, permitted by the SCTP 
implementation for the retry timeout.

Bundle Chunks Indicates whether the SCTP protocol allows chunks to be bundled into a 
single datagram as follows. Valid values are:

• true (1)—Chunks are bundled.

• false (2)—Chunks are not bundled.

Bundle Timeout (msecs) Time, in milliseconds, to wait to allow data chunks to accumulate so that 
they can be transmitted in the same datagram.

Field Description
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